
Codebook and Instructions on Coding Thai Election Posters 

This file contains five sections 
A. An introduction to the project 
B. Procedure and poster eligibility for study 
C. Instructions on measuring spatial aspects of variables 
D. Spatial variable operational definitions 
E. Content variable operational definitions 

A. Introduction 

Background 
During the 2011 election campaign, I photographed about 12,000 election posters. I 
photographed these while riding on the back of a motorbike and crisscrossing towns in the North, 
the Northeast, Bangkok, and in the South and Deep South. Every poster I saw was photographed 
and each photo was stamped with a GPS location. I then selected every unique poster design for 
coding—almost 600 posters. Each of these have been cropped to fill the frame of the image. 

Poster Content 
Posters contain different kinds of images: 

• Images of political elites (leaders of parties and other party elites) 
• Images of SMD constituency and PR List candidates 
• Images related to party or candidate messages (e.g. An ATM machine, a fast train, a group 

of students) 
• Party Logos 

They also contain text messages: 
• Party names and numbers 
• Names of party elites and candidates 
• Policy and issue messages 
• Slogans 
• Calls to action, to go out and vote 
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The Research Project 
For this research project I want to code the visual and textual content of the election posters and 
the percentage of space on election posters that is dedicated to them. Specifically, I’m interested 
in the space dedicated to candidates and the space dedicated to the party name, party leaders, 
policy appeals, and slogans. I want to find out the percentage of space on each poster that is 
dedicated to these different elements. To do so we will use some specialized software to trace the 
space that different elements on the poster take up. 

B. Procedure and Poster Eligibility for Study 

The posters first need to be sorted by political party and unique design. Each uniquely designed 
poster is given a unique poster number for each party. A party number combined with the poster 
number represents a unique poster item number. E.g. Pheu Thai party was the number 1 party, so 
the first of their posters was indexed as 01-001, the second was 01-002 etc. The clearest example 
of each poster design will be coded.  

Posters will be removed and not be coded, if: 
1. If they were not for the national election 
2. If they were not for a political party competing in the election. The yellow shirt social 

movement put up a lot of posters featuring animals urging voters to spoil their votes. 
3. If clearest example of a poster design is not easily readable. Often text messages are 

repeated, so posters with blurred text or partly cut off should be compared with other 
posters from the party before being removed. 

D. Instructions on Measuring Spatial Aspects of Variables 

To measure the space on posters we will use a program called ImageJ (Fiji). It allows us to draw 
freehand shapes on a poster and it will output the area in terms of the number of pixels. From 
that, I can use statistical software to out the percentage of space of the whole poster that each 
element takes up. In Fiji you will spend your time making a selection around an element, turning 
it into an overlay, applying a label.  
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A few points on selections and overlays: 
• You can make selections in ImageJ and they are temporary. 
• You can turn a selection into an overlay element. This is permanent and gets saved with the 

tiff image 
• Labels also get saved with the tiff image. 

Software Setup 
• Software used to trace the images is called ImageJ. There is a version of ImageJ (that has a 

suite of plugins) called Fiji that we will use. Fiji is free and it works on PCs and Macs. 
Download the PC or mac version here: 

• http://imagej.net/Fiji 
• You need to do the setup each time you open imageJ. 

Setup 1: Overlay to be Transparent Color 
1. Image > Overlay > Overlay Options.  
2. For Fill Color put in #6600ffff This will give overlays a transparent blue fill. 
3. Select Show Labels (leave other options as they are) 

Setup 2: For Making Label Name Visible 
1. Go to, Image > Overlay > Labels 
2. Use options: Color: white, Font Size: 12. Select all the other options (show labels, use 

names as labels, draw backgrounds, bold) 

Using the Software to Measure Spatial Dimensions 
Detailed instructions below explain how to measure spatial dimensions on the posters. It uses the 
examples of measuring and labeling the size of the party logo with an ‘l’ and the party name with 
an ’n’. 

1. Open a File and Make A Selection 
1. Opening Files: Can open one at a time, or open one and then do ‘open next’. It should 

open the next (alphabetically) file in the folder. 
2. Making Selections: Use any of the selection tools. Square/rectangle tool can be used with 

some text, or the polygon or freehand for more irregular shapes. Use whatever is quickest 
and relatively precise. Make a selection around the party logo. Make sure you include all 
of the logo, but be fairly tight in the selection. 
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3. Moving and Modifying Selection. You can adjust those ones with handles. You can use 
the arrow keys to nudge. Brush Selection tool can be used to change contours, though it 
is awkward to use. 

4. Deselect Selection: Often if you make a mistake it is easiest to start again. Simply 
deselect by clicking outside the selection. Then the selection will disappear. 

2. Make the Selection into an Overlay Element and Label it 
1. Make a Selection an Overlay: type b (if you need to delete an overlay element, you can 

select it and hit delete. If you want to hide or show all overlays go to 
Image>Overlay>Hide Overlay (or Show Overlay) This is not necessary though. 

2. Deselect Overlay Element & Select Again: After you make an overlay element you need 
to deselect it and select it again. Click outside the overlay to deselect it. Then, option-
click on the overlay element (this doesn’t seem to work with the polygon tool selected, 
but does with other tools) Or you can long-click on the element.  

3. Make Label for the Name Text: Hit y. This brings up a dialogue box. Type in the name 
for the element ‘l’. Put in the color #6600ffff (you can do a copy paste for the color) 

4. Party Number: Repeat the process above to make an overlay of the party number. Label 
these ’n’. 

5. Save the file: apple-s 
6. Open Next: shift-apple-o, this will close the current file and open the next one (in 

numeric order). Make sure you save the previous file before doing this. (There is no 
warning to save changes). A slower way is to close the previous file and then go to file > 
open and open the next one. 

D. Spatial Variable Operational Definitions 

General Rules on Tracing 
• For irregular shaped objects like politicians bodies, text and text messages, trace relatively 

tight to the element. 
• If an element is designed into a box or other solid shape with no transparency, trace the 

whole shape. For example, many party numbers are in boxes. 
• When politicians’ bodies are overlaid with text with transparency (i.e. the text is not boxed 

off) trace the whole area of the body and head under the text. 
• When tracing faces, trace from the chin up and around the forehead, regardless of hairline. 

Do not include ears. 
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PART 1. CANDIDATES 
Most of the time posters will contain one SMD candidate or one PR list candidate, or no 
candidates. Check lists of candidates to make sure they are SMD or PR List candidates. While it 
is very rare, if there are more than one SMD or PR List candidate on a poster, label the face of 
the first one ‘cf’ and the second one ‘cf2’, reading from left to right. Do the same for the other 
spatial measurements of candidates. 

Candidate references include messages that refer to them personally, what they will personally 
do for the local constituency, or specifically asks for a personal vote. Examples include:  

• “Vote for Sugarno Matha.” (Pheu Thai candidate) 
• “I speak my mind. I live simply. I do what I say. I want to serve people.” (Pheu Thai 

candidate) 
• “I love my hometown, I'm honest, I've done good jobs, I have a stable political 

ideal.” (Democrat candidate) 
• “I will work for people. I will clear's someone's else's fault.” (Democrat candidate) 

What is not a specific reference: 
• If they say “Increase subsidies for farmers” or “Develop infrastructure,” it is not a personal 

reference to the candidate. It is however, a policy appeal. 
• They must specifically reference the candidate. “Vote number one. Please vote for both the 

candidates and the party.” Should not be coded. These are common phrases across many 
candidate posters and they do not indicate personalization. 

SV1: SMD candidate face: label = cf 

SV2: SMD candidate body: label = cb 

SV3: SMD candidate name: label = cn 

SV4: SMD candidate reference: label = cr 

SV5: PR List candidate face: label = pf 

SV6: PR List candidate body: label = pb 
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SV7: PR List candidate name: label = pn 

SV8: PR List candidate reference: label = pr 

PART 2. PARTY LEADERS 
Candidate references include messages that refer to the party leader (or defacto leader) 
personally or specifically asks for a personal vote. Examples include: 

• “Yingluck will be Prime Minister” (Pheu Thai leader) 
• “Thaksin thought to do it for Thais. He did it for us and supported us.” (Pheu Thai de facto 

leader) 
• “Vote for Chuwit, mark on no. 5 for party list. He is harmonious...when wants an 

advantage. He is malicious...when disagrees.” (Rak Thailand leader) 
• Follow instructions on what is not a specific reference from the candidate section above. 

SV9: Leader face: label = ef 

SV10: Leader body: label = eb 

SV11: Leader name: label = en 

SV12: Leader reference: label = er 

PART 3. PARTY LABEL 
If the party name or logo appears more than once, label the fist one ‘l’ and the second one ‘l2’. 
Logos sometimes have a small short slogan that is designed into the party name/logo. In these 
cases, include the short slogan when tracing the party logo. 
Party numbers often appear in solid boxes. If so, tace the whole box. 

SV13: Party logo or name: label = l 

SV14: Party number: label = n 
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PART 4. POLICY 
Policy messages need to be specific enough to fit into one of the pre-defined policy categories 
(see Options for Policy text below). If policy messages relate to different policies, trace them 
separately. The first policy message will be labeled ‘pt’, the second one ‘pt2’. If an image is 
associated with a particular policy, it should align with the coding of the policy text. For 
example, if an image related to the second policy on a poster it should be labeled ‘pi2’. 

SV15: Policy text: label = pt 

SV16: Policy image: label = pi 

PART 5. SLOGANS 
General slogans are common on posters. They differ from policy in that they cannot easily fit 
into one of the policy categories (see Options for Policy text below). Examples include: 

• “For Thais, for the future of Thailand” (Pheu Thai Party) 
• “Proceed with policies for the public” (Democrat Party) 
• “We do what we say, brave to do it for Thais” (Bhumjaithai Party) 

In addition, slogans are often repeated across many posters, usually in the same position. If a 
slogan is designed into the party logo it should only be traced with the logo. If there is more than 
one slogan, trace them separately. 

SV17: Slogan: label = s 

Exporting measures out of Fiji and into an excel sheet. 
Option 1: Getting data out one poster at a time. 

1. Open file. 
2. Use shortcut to do a Image > Overlay > To ROI 
3. In ROI Manager hit measure 
4. Close file. Do not save before closing. 
5. Open another file and repeat. When you do a ‘To ROI’ it will delete what is in the ROI 

manager and replace it. And when you do a measure, it will add it to the Results table 
under the results from the previous image. 

19



Option 2: Automated way to get all data out 
1. Go to Plugins > New > Macro 
2. Paste the code below into the box as many times as there are posters. This will process all 

the posters. 
  run("To ROI Manager"); 
  roiManager("Measure"); 

3. Hit run. It will save the overlay coordinates and points to an input box. 
4. Select all the data in this box and save as an Excel file. 

E. Content Variable Operational Definitions 

PART 1. INDEX FIELDS 

CV1: Party poster number: (assigned) — party number-unique party poster number 

CV2: Poster width: Width of poster in pixels 

CV3: Poster height: Height of poster in pixels 

CV4: Party: Pick the party number from the list of party names 

List of options for party 

1 Pheu Thai
2 Chart Pattana Puea Pandin
3 New Democracy 
4 Thai Citizen 
5 Rak Thailand
6 Palung Chon
7 Prachathum
8 Dumrongthai 
9 Mass Power

10 Democrat
11 Thai Por Pieng
12 Rak Santi
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CV5: Election: (assigned) — SMD or PR 

The geo-coded location of reprints of the poster is checked to decide if it is SMD or PR 
SMD: if the poster is only in one constituency and has a constituency candidate name 
PR: if the poster is posted in more than one constituency. 

13 Thaipensuk
14 Social Action
15 Thai Pen Thai 
16 Bhumjaithai
17 Thaen Khun Phaendin
18 For Heaven and Earth 
19 The Farmer Network Of 

Thailand20 New Politics
21  Chartthaipattana
22 Liberal
23 Chart Samuccee 
24 Bamrungmueang 
25 Kasikornthai
26 Matubhum
27 Better Life
28 Palung Sungkom Thai
29 Thai Party for Thai People
30 Mahachon 
31 Prachachon Chow Thai
32 Rakpandin
33 Civil Peace
34 New Aspiration
35 Asamatupoom
36 Sport Of Thailand
37 Parung Chownathai 
38 Thai Sangsun
39 Puen Kaset Thai
40 Maharatpattana 
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CV6: Province name: (assigned) — from geo-coded information 

CV7: Constituency number: (assigned) — from geo-coded information 

CV8: SMD candidate sex: 
 Male 
 Female 

CV9: PR candidate sex: 
 Male 
 Female 

CV10: Party leader sex:  
 Male 
 Female 

CV11: SMD candidate picture: 
 Y 
 N 

CV12: PR candidate picture: 
 Y 
 N 

CV13: Party leader picture:  
 Y 
 N 

PART II. CLOTHING FIELDS 

Party Clothing 
Candidates were marked ‘yes’ for wearing party clothing if their clothing was official party 
clothing in party colors and/or had a visible party logo on the clothing. 

CV14: SMD candidate party clothing: 
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 Yes 
 No 

CV15: PR candidate party clothing: 
 Yes 
 No 

CV16: Party leader party clothing: 
 Yes 
 No 

Clothing Style 
CV17: SMD candidate clothing: Select from list of options below 

CV18: PR candidate clothing: Select from list of options below 

CV19: Party leader clothing: Select from list of options below 

List of options for clothing 
1. Suit and tie: This is formal clothing, business suit and tie. 
2. Suit: This is also formal. For men it includes a suit but no tie. For women, it is formal 

business suit type jacket and can include pants or a dress. 
3. Jacket and tie: A jacket here refers to any kind of jacket that is not a formal business suit 

jacket. Often they are the casual ‘bomber’ type party jackets. 
4. Jacket: As above, just no tie. 
5. Shirt: Button-up collar shirt with no tie or jacket. Can also be a simple t-shirt. 
6. Graduation & Lawyer uniform: The formal uniforms. 
7. Government uniform: The formal government uniforms. 
8. Ethnic or religious: Mostly it includes Islamic clothing on candidates in the south. For 

other clothing suspected of being some form of ethnic Thai clothing, note it for 
discussion with the group. 

9. Sporting: Includes soccer clothing, or any other sport-specific attire. 
10. Other: Any clothing that doesn’t fit into these categories note for discussion. 
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PART III. TEXT FIELDS 

Policy fields 
The policy text field coded the policy textual message according to one of the options below. If a 
poster referred to more than one policy, the text (and any associated image) a 2, 3 etc. was added. 
The number of the policy should align with the spatial label in the poster. Policy text translation 
should contain all the policies with numbers to indicate which one they refer to. 

CV20: Policy text: Select from list of options below 

CV21: Policy text translation: English translation of the policy text(s) 

CV22: Policy image description: Description of policy image 

Options for Policy text with examples 
ECONOMY 

1. National budget and debt: Decrease the national debt. Increase in the national budget. 
2. Local budgets and debt: Village Volunteers & committees. Bringing funds to the local 

level. Tackling debt at the local level. 
3. Macro economy: Foreign trade, interest rates etc. 

INFRASTRUCTURE & TRANSPORTATION 
4. Roads and infrastructure: Building better roads; stopping flooding; making the city 

more livable and more clean; creation of parks; and the protection of wildlife. 
5. Transportation: Development of urban and provincial trains, railway lines, and buses. 

Development of airports. Subsidies for travel for students, elderly. Other support for 
public transportation. 

GOVERNMENT SERVICES 
6. Health and education: Health policies; investment in schools and universities; support 

for student tuition; training programs; tablets for students; and loans for career (training). 
7. Pensions: Welfare for the elderly 
8. Poverty and welfare: Helping the poor and reducing poverty 
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EMPLOYMENT 
9. Jobs: Reference to jobs or work in general. Creating a fund to foster employment. 

References to decreasing unemployment. 
10. Wages salaries and wealth: References to increasing salaries and wages. 
11. Taxes: Messages relating to income tax 

CONSUMER GOODS 
12. Home and car/motorbike: Provide help for first-time home buyers. Help with 

mortgages. Efforts to provide affordable housing. Provide help with buying a car or a 
motorbike 

13. Other consumer goods: Prices of gas, benzene, diesel. Goods (unspecified) will be 
cheaper. VAT 

BUSINESS & FARMING 
14. Farming: Any policy on farming. Includes raising the income of farmers, policies on 

irrigation, subsides, technical help, and insurance schemes 
15. Tourism: Support for tourism and tourist businesses 
16. Sports industry: Support and development of sports; building stadiums; and helping 

athletes become professional 
17. Other businesses: Messages on promoting other small business; support for 

entrepreneurs (can be unspecified industries); and loans for vendors and small businesses 

RULE OF LAW 
18. Corruption: Message of being hard on corruption 
19. Drugs: Message of being hard on drugs 
20. Crime and violence: Hard on petty crime and violence 

OTHER 
21. Culture: Messages relating to policy on arts and culture 
22. Religion: Policy-relevant messages on religion 
23. International affairs: Policy-relevant messages on international affairs 
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Name of variables in codebook and in the csv/stata file (posters_unique.csv)

CV Var. title (codebook) Var. name (csv/stata)

PART I. INDEX FIELDS

CV1 Party poster number pos_id

CV2 Poster width pos_width

CV3 Poster height pos_height

CV4 Party party

CV5 Election election

CV6 Province Name prov

CV7 Constituency number con

CV8 SMD candidate sex cansmd_sex

CV9 PR candidate sex canprl_sex

CV10 Party leader sex leader_sex

CV11 SMD candidate picture cansmd_pic

CV12 PR candidate picture canprl_pic

CV13 Party leader candidate picture leader_pic

PART II. CLOTHING FIELDS

CV14 SMD candidate party clothing cansmd_partyclothing

CV15 PR candidate party clothing canprl_partyclothing

CV16 Party leader party clothing leader_partyclothing

CV17 SMD candidate clothing cansmd_clothing

CV18 PR candidate clothing canprl_clothing

CV19 Party leader clothing leader_clothing

PART III. TEXT FIELDS

CV20 Policy text (cv20.1-20.4) p1, p2, p3, p4

CV21 Policy text translation policy_text

CV22 Policy image description policy_image
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